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Before Installing v9.0 

Predator MDC v9.0 requires Windows 2000, XP, 2003 Server, 2008 Server or Vista.  

Existing customers that have older versions of Windows such as Windows 95, 98, ME or 

NT v4.0 must upgrade prior to installing v9.0 of Predator MDC. 

Existing MDC customers should backup the database prior to upgrading.  Predator MDC 

Administrator v9.0 will upgrade the database automatically from older v1.x, v2.x, v3.x, 

v7.x or v8.x versions to v9.0.  After the database has been upgrade to v9.0 older versions 

of Predator MDC will not be able to use the database. 

Microsoft Internet Explorer v5.x or later and the Microsoft .NET Framework 2.0 is 

required to be installed before installing Predator MDC v9.0. 

Why v9.0? 

By design, the primary goal of this release is intended to provide more insight to shop 

floor productivity.  Significantly 684 new reports and charts have been added for a total of 

1324.  In addition, we have significantly improved Predator MDC to support more 

dashboard and digital signage applications. Numerous new features and improvements 

have been added for better data collection and day to day operation. Along the way 

support for Windows 2008 Server and Microsoft SQL Server 2008 have been added. 

Details of what’s new are explained throughout this document and within the online help. 

Installing v9.0 

The v9 installation is based on a single .MSI image and .CAB files have been eliminated.  

If you are running Windows 98, ME or NT v4.0 you must upgrade to Windows 2000, XP, 

2003 Server or Vista prior to installing v9.0 of Predator MDC.  

NOTE: Predator MDC Service and Predator MDC for DOS are installed automatically 

with Predator MDC.  Like other DOS applications Predator MDC for DOS does not run 

under Windows Vista x64. 

By default installation occurs in the \program files\predator software\mdc 9.0 directory.  If 

you were previously running v8.x we recommend uninstalling v8.x prior to installing v9.0. 
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 V9.0 Serial Numbers and Access Codes 

Version 9 includes a serial number and an access code that are required after the installation 

during registration of the software. 

NOTE: The serial number must start with 09 if this is not the case contact us. 

Predator MDC  

 

Network Installations of v9.0 

By committing to store the product installation on a server, users will enjoy automatic healing 

of all critical files upon running Predator MDC.  For example, suppose a user accidentally 

deletes pmdc.exe. Under normal circumstances he would be down and the software would 

fail to run.  With v9.0 when the user double clicks the desktop shortcut all critical files are 

checked and if necessary restored from the network server and the software begins to run 

automatically. 

The easiest way to perform a network installation is to step through the following: 

1. Copy the contents of the CD to a \predator cd images\CD39\ or similar directory. 

2. Run the setupmdc.exe from the CD39 directory. 

NOTE: Should any automatic healing be necessary, Predator MDC will be able to 

automatically extract the necessary files from the appropriate files stored in the CD39 

directory.  If you install from a CD, Predator MDC will be forced to prompt for the CD. 

 

What’s New in v9.0? 

New! Microsoft Windows 2008 Server Support 

Support for Microsoft Windows 2008 Server has been added with v9.0 of Predator MDC. 

New! Microsoft SQL Server 2008 Support 

Support for Microsoft SQL Server 2008 has been added with v9.0 of Predator MDC. 

New! Microsoft SQL Server 2008 Express Support 

Support for Microsoft SQL Server 2008 Express has been added with v9.0 of Predator CNC 

Editor Enterprise.  Support for this edition of SQL Server provides a free version of Microsoft 

SQL Server for small and medium manufacturers.  The Express edition can be downloaded 

from Microsoft’s web site. 

New! View Data Collection Errors 

A new View > Data Collection Errors menu has been added to v9.0 of Predator MDC.  This 

new option allows all data collection errors to be viewed prior to fixing the errors. 

New! Report Date Ranges 

Most reports have been redesigned with specific From and To Dates.  This is more flexible 

then the previous method.  Custom date ranges can now be specified along with 12 new 

shortcuts including Today, Yesterday, This Week, Last Week, Last 7 days, Last 30 days, 

This Month, Last Month, This Quarter, Last Quarter, This Year and Last Year. 
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 New! Chart Date Ranges 

Most charts have been redesigned with specific From and To Dates.  This is more flexible 

than the previous method.  Custom date ranges can now be specified along with 12 new 

shortcuts including Today, Yesterday, This Week, Last Week, Last 7 days, Last 30 days, 

This Month, Last Month, This Quarter, Last Quarter, This Year and Last Year. 

New! View Job Status 

Predator MDC v9.0 adds a new View Job Status dashboard displaying jobs, job status, 

customer, part number, target start, actual start, target end, actual end, target quantities, 

good parts, machine time, setup time, cycle time, downtime, teardown time and idle time.  

Actual start and end dates are automatically color coded to indicate on time, not started or 

late.  Job filters for pending, in-process and completed can narrow the number of jobs 

displayed.  Real-time updates every X seconds are supported.  Columns can be hidden.  

Options for changing the font and status colors are included.  Preferences are automatically 

saved per user. The View Job Status dashboard is designed to support LCD and Plasma 

based digital signage. 

 

 

 New! View Job Status Command Line 

Predator MDC v9.0 adds a new View Job Status command line.  Creating a Windows 

shortcut with this command line can facilitate digital signage.  Refer to the following 

examples: 

     pmdc.exe –jobstatus 

     pmdc.exe –user jima –password predator -jobstatus 

New! View Part Status 

Predator MDC v9.0 adds a new View Part Status dashboard displaying parts, actual start, 

actual end, good parts, machine time, setup time, cycle time, downtime, teardown time and 

idle time.  Part filters for active parts and date ranges narrow the number of parts displayed.  

Real-time updates every X seconds are supported.  Columns can be hidden.  Options for 

changing the font are included.  Preferences are automatically saved per user. The View Part 

Status dashboard is designed to support LCD and Plasma based digital signage. 
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 New! View Part Status Command Line 

Predator MDC v9.0 adds a new View Part Status command line.  Creating a Windows 

shortcut with this command line can facilitate digital signage.  Refer to the following 

examples: 

     pmdc.exe –partstatus 

     pmdc.exe –user jima –password predator -partstatus 

New! Setup Cycle Status Locking 

A new option allows setup time to be locked within v9.0 of Predator MDC.  When setup time 

is locked cycle starts and cycle ends will be discarded and the machine will stay in setup 

until a setup end, machine downtime start or teardown start is received. 

NOTE:  This option can be enabled within the Predator MDC Database Service Manager.  

New! Teardown Cycle Status Locking 

A new option allows teardown time to be locked within v9.0 of Predator MDC.  When 

teardown time is locked cycle starts and cycle ends will be discarded and the machine will 

stay in teardown until a teardown end, machine downtime start or setup start is received. 

NOTE:  This option can be enabled within the Predator MDC Database Service Manager.  

New! Machine Downtime Status Locking 

A new option allows individual machine downtimes to be locked within v9.0 of Predator 

MDC.  When a specific machine downtime is locked cycle starts and cycle ends will be 

discarded and the machine will stay in the specific machine downtime until a machine 

downtime end, teardown start or setup start is received. 

NOTE:  This option can be enabled within the Predator MDC Database Service Manager.  

New! 14 Good vs. Scrapped Charts 

Fourteen new bar charts displaying good and scrapped quantities have been added to v9.0 

of Predator MDC. Clicking on the bar will display a tool tip.  These new charts are grouped 

by department, location, group, machine, shift, user, part type, part, job, operation, daily, 

weekly, monthly and quarterly. 

New! 14 Finished vs. Unfinished Charts 

Fourteen new bar charts displaying finished and unfinished cycles have been added to v9.0 

of Predator MDC. Clicking on the bar will display a tool tip.  These new charts are grouped 

by department, location, group, machine, shift, user, part type, part, job, operation, daily, 

weekly, monthly and quarterly. 

New! 14 Hours Summary Charts 

Fourteen new bar charts displaying hour summaries have been added to v9.0 of Predator 

MDC. Clicking on the bar will display a tool tip.  These new charts are grouped by 

department, location, group, machine, shift, user, part type, part, job, operation, daily, 

weekly, monthly and quarterly. 
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 New! 14 Cycles and Parts Charts 

Fourteen new bar charts displaying cycles and part quantities have been added to v9.0 of 

Predator MDC. Clicking on the bar will display a tool tip.  These new charts are grouped by 

department, location, group, machine, shift, user, part type, part, job, operation, daily, 

weekly, monthly and quarterly. 

New! 4 Machine Time and Cost Charts 

Four new bar charts displaying Machine Time and Cost charts have been added to v9.0 of 

Predator MDC.  These new charts are grouped by daily, weekly, monthly and quarterly. 

New! 4 Machine Downtime and Cost Charts 

Four new bar charts displaying Machine Time and Cost charts have been added to v9.0 of 

Predator MDC.  These new charts are grouped by daily, weekly, monthly and quarterly. 

New! 14 Scrap Code Summary Charts 

Fourteen new bar charts displaying scrap code summaries have been added to v9.0 of 

Predator MDC. Clicking on the bar sections will display a tool tip.  These new drilldown style 

bar charts are grouped by department, location, group, machine, shift, user, part type, part, 

job, operation, daily, weekly, monthly and quarterly.  The consolidate style is a pie chart as 

it was in previous versions. 

New! 10 Trend Analysis Charts 

Ten new trend analysis charts displaying plot and area style charts have been added to 

v9.0 of Predator MDC. Clicking on a plot point will display a tool tip.  These new drilldown 

style bar charts are grouped by department, location, group, machine, shift, user, part type, 

part, job, and operation.  The consolidate style is a plot and area style chart as it was in 

previous versions. 

New! 4 Performance Ranking Charts 

Four new bar charts displaying Performance Ranking charts have been added to v9.0 of 

Predator MDC.  These new charts are grouped by daily, weekly, monthly and quarterly. 

New! Vertical / Horizontal Style Charts 

New vertical / horizontal style right mouse options have been added to all Machine Time and 

Cost charts, Machine Downtime and Cost charts, Scrap Code Summary charts and 

Performance Ranking charts within v9.0 of Predator MDC.  Right click on any chart to set the 

landscape option.  This new chart preference is automatically saved per windows user. 

New! Landscape Style Charts 

New landscape style option has been added to all charts.  Right click on any chart to set the 

landscape option within v9.0 of Predator MDC.  This new chart preference is automatically 

saved per windows user. 

New! Predator PDM Compatibility 

Support for Predator PDM v9 has been added with v9.0 of Predator MDC. 

 



 

Predator MDC – What’s New  

Latest features and benefits of v9.0 6 

 New! 100 Production Detail Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new Production Detail reports within v9.0 

of Predator MDC. 

New! 100 Scrap Code Summary Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new Scrap Code Summary reports within 

v9.0 of Predator MDC. 

New! 100 Machine Downtime Summary Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new Machine Downtime reports within 

v9.0 of Predator MDC. 

New! 100 User Downtime Summary Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new User Downtime reports within v9.0 

of Predator MDC. 

New! 100 Machine Time Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new Machine Time reports within v9.0 of 

Predator MDC. 

New! 100 Machine Cost Reports 

A hundred new sub group combination reports have been added via two levels of sub groups 

including By Department, By Location, By Group, By Part Type, By Part, By Job, and By 

Operation. These new sub groups provide over 100 new Machine Cost reports within v9.0 of 

Predator MDC. 

New! Missing Realtime Data Report 

A new Missing Realtime data report has been added to the Administrator menu.  This report 

identifies missing components such as part numbers, jobs, and users that have not been 

added to Predator MDC but data collection has occurred.  This report reviews all of the data 

collection errors to identify the specific components that need to be added.  Once these 

missing components have been entered within Predator MDC the Reprocess Data Collection 

Errors command can be run to automatically cleanup the data collection errors. 
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 New! Add to Automation 

Most charts can now be automated within a continuous real-time slide show.  Digital 

signage can be setup with a low cost PC and Predator MDC Client.  From within most 

charts simply select Add to Automation from the File menu.  A dialog with options to save 

the file, display time and title can be specified. 

New! Slide Show Mode 

Predator MDC v9.0 adds a new real time Slide Show mode of operation.  This mode is 

initialized with the –slideshow command line.  While running in this mode Predator MDC will 

continuously loop through the charts specified within the automation text file.  The title an 

amount of time each chart is displayed is also configured within the automation text file.  

This file can be edited offline with the Predator CNC Editor or any 3
rd

 party text editor.  

Pressing the Esc key will exit this mode and return to standard operation.  While in slide 

show mode you can push the Pg Up and Pg Dn keys to skip backwards or forwards to the 

next chart.  The current chart can be printed by right clicking and selecting Print.   

NOTE: Typically a dedicated PC is provided for digital signage and it is recommended that 

toolbars, status bars and other screen elements be disabled in a digital signage setup. 

Charts are displayed in full screen but it is recommended that all bar charts be displayed 

horizontally.  This is especially true with 16:9 style wide screen displays. 

 
 

 
New! Slide Show Command Line 

Predator MDC v9.0 adds a new Slide Show command line.  This command line requires an 

automation text file to be referenced after the –slideshow command line.  Creating a 

Windows shortcut with this command line can facilitate digital signage.  Refer to the 

following examples: 

     pmdc.exe –slideshow automation.txt 

     pmdc.exe –user jima –password predator –slideshow automation.txt 
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 New! Reprocess Data Collection Errors 

A new Reprocess Data Collection Errors has been added to the Administrator menu.  This 

command fixes data collection errors after the administrator fixes missing components such 

as part numbers, jobs, and users.  The overall procedure to fix data collection errors should 

be the following: 

1. From the Administrator menu select Missing Realtime Data Report 

2. Add the missing component(s) identified in step 1 

3. From the Administrator menu select Reprocess Data Collection Errors 

4. From the View menu select View Data Collection Errors 

5. From the Process menu select Fix Data Collection Errors 

Take note of what data collection errors are occurring.  Often these issues can be minimized 

with additional training and improved procedures.  The new tools within Predator MDC v9 

simplify overall administration of data collection errors. 

New! Import Errors Report 

A new Errors report has been added to the Import wizard within v9.0 of Predator MDC.  This 

report will provide a list of all the import errors that Predator MDC identifies.  This reduces the 

trial an error process when cleaning up bad csv files. 

New! Remember Password 

A new Remember Password option has been added to v9.0 of Predator MDC.  Enabling this 

option will automatically logon the user to Predator MDC. The password is stored in a secure 

manor per Windows user. 

New! Job Status and Part Status Toolbar Buttons 

Two new toolbar buttons have been added for Job Status and Part Status dashboards. 

New! User Object within MDC APIs 

A new user object has been added to v9.0 of Predator MDC API to allow Predator users to be 

created, edited and deleted. These new methods can provide a more robust integration with 

ERP, MES and other business systems. 

New! LastLogin API 

A new lastlogon API has been added which requires the Remember Password option be 

enabled.  The advantage of this method is that database and user credentials are not visible 

within a vbscript, VBA macro, windows script or jscript. 

New! Solidworks eDrawings Support 

Predator MDC includes Solidworks 2010 eDrawings support for viewing Solidworks 

assemblies, parts and drawings. In addition Autocad DWG and DXF files are supported. 

New! Microsoft Visio Support 

Predator MDC includes Microsoft Visio support for viewing Microsoft Visio drawings. 
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Improved! Microsoft Word Support 

Predator MDC includes Microsoft 2007 Word support for viewing Microsoft Word, 

Wordperfect, Works and RTF documents. 

Improved! Microsoft Excel Support 

Predator MDC includes Microsoft 2007 Excel support for viewing Microsoft Excel 

spreadsheets. 

Improved! Microsoft Powerpoint Support 

Predator MDC includes Microsoft 2007 Powerpoint support for viewing Microsoft 

presentations. 

Improved! Adobe Acrobat Reader Support 

Predator MDC includes Adobe Acrobat Reader v9.2 for viewing PDF documents.  This 

includes 3D PDFs. 

Improved! Machine Status Toolbar Button 

The Machine Status toolbar button has been improved to be similar to the new Job Status 

and Part Status toolbar buttons. 

Improved! Importing 

Importing CSV files has been improved to automatically create new components or update 

existing components with new details.  New checkbox options have been added to ignore 

errors and to display an error report.  The ignore errors option can be used when the csv file 

contains known errors that you don’t want to fix and you wish to force the import to continue 

with the remaining good data.  The error report allows you to quickly fix a number of errors 

within a csv file prior to importing the csv file. 

Improved! OEE Report 

Improved OEE report by eliminating <No Part> details. 

Improved! Trend Analysis Charts  

All Trend Analysis charts have been improved with Daily, Weekly, Monthly and Quarterly 

options.  In addition Next Set and Previous Set chart right mouse shortcuts have been added 

when drilldown style charts are displayed.  Finally, keyboard shortcuts for home, end, pg dn 

and pg up keys have been added when drilldown style charts are displayed. 

Improved! Predator MDC Service 

The Predator MDC Service has been improved to support optional setup, teardown and 

machine downtime style cycle locking. 

Improved! Machine and Job Status Panel 

The machine status and job status panel has been improved to display the number of data 

collection errors. 

NOTE: Machine Status Panel is not available with Predator MDC Express.  

Improved! Productivity Summary Chart 

The Productivity Summary Chart has been improved with a new right mouse option called 

Show Cost.  Toggling this option will enable or disable the display of costs. 
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 Improved! Machine Time and Cost Chart 

The Machine Time and Cost Chart has been improved with a new right mouse option called 

Show Cost.  Toggling this option will enable or disable the display of costs.  In addition, the 

order of setup time and cycle time have been swapped to better drive improvements to 

cycle time and to group all down times together. 

Improved! Machine Downtime and Cost Chart 

The Machine Downtime and Cost Chart has been improved with a new right mouse option 

called Show Cost.  Toggling this option will enable or disable the display of costs. 

Improved! Event Time Analysis Chart 

The Event Time Analysis Chart has been improved with new right mouse tool tips 

displaying the parameter field for machine downtimes, user downtimes, job numbers and 

part numbers. 

Improved! Machine Events Report 

The Machine Events Report has been improved with a new difference column and 

improved layout for enhanced readability. 

Improved! Fix Data Collection Errors Wizard 

The Fix Data Collection Errors Wizard has been improved to automatically fix some errors 

within v9.0 of Predator MDC. 

Improved! Select Criteria Right Mouse Menu 

The Select Criteria right mouse menu is now always the first item in all charts.  This makes 

it easier to change filters, date ranges and other options. 

Improved! Pulldown Performance 

Pulldowns for departments, locations, groups, machines, part types and parts have been 

improved for greater performance with large datasets within all dialogs.  For example 

100,000+ part numbers can be selected and changed in less than 1 second.  Support for up 

arrow, down arrow, pg up, pg dwn, ctrl+up arrow and ctrl+down arrow has been improved 

within pulldowns as well. 

Improved! MDC for Haas 

The MDC for Haas object has been improved to support Haas machines running in 

Spanish. 

Improved! Quality % Calculations 

Improved quality % calculations when zero good parts and zero scrapped parts occur.  In 

previous versions Predator MDC would report a quality of 0%.  In this case Predator MDC 

v9.0 calculates a quality of 100%.  In v9.0 the only time 0% quality is reported or charted is 

when zero good parts and one or more scrapped parts occur. 

Improved! Overlapping Shifts 

Support for overlapping shifts has been improved. 

Improved! Machine Hours with Hours Summary Chart 

Support for machine hours within the Hours Summary Chart has been improved. 
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 Improved! Predator CNC Editor Enterprise Compatibility 

Support for Predator CNC Editor Enterprise v9 has been improved with v9 of Predator 

MDC. 

Improved! Predator DNC Compatibility 

Support for Predator DNC v9 has been improved with v9 of Predator MDC. 

Improved! Predator Travelers Compatibility 

Support for Predator Travelers v9 has been improved with v9 of Predator MDC. 

Improved! Predator Tracker Compatibility 

Support for Predator Tracker v9 has been improved with v9 of Predator MDC. 

Improved! Predator Virtual CNC Compatibility 

Support for Predator Virtual CNC v9 has been improved with v9 of Predator MDC. 

Improved! Chinese Language Support 

Support for Chinese has been improved with v9 of Predator MDC. 

Improved! HTML based Online Help 

Updated online help expands several topics with new details. 

Bug Fix! SIM ID Button 

Predator MDC v9.0 fixes a bug displaying the SIM number of remote SIMs within Windows 

Remote Desktop. 

 

 

 

 

For the latest on Predator MDC, check our web site at 

http://www.predator-software.com 

 


